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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON product. EPSON is not responsible for any use of this information as applied to other 
products.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

EPSON is a registered trademark of SEIKO EPSON CORPORATION.

EPSON Extra Care, EPSON Connection and EPSON Store are service marks, and PrivateLine and PowerLite are 
registered trademarks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

Copyright © 2003 by Epson America, Inc. 11/03
CPD-16677R1
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Important Safety Information

Follow these safety instructions when setting up and using the projector:

■ Never look into the projector lens when the lamp is turned on; the bright light can 
damage your eyes. Never let children look into the lens when it is on.

■ Never open any cover on the projector, except the lamp and filter covers. Dangerous 
electrical voltages inside the projector can severely injure you.

■ Except as specifically explained in this User’s Guide, do not attempt to service this product 
yourself. Refer all servicing to qualified service personnel.

■ The projector and its accessories come packaged in plastic bags. Keep plastic bags away 
from small children to avoid any risk of suffocation.

■ Don’t place the projector on an unstable cart, stand, or table. Also, don’t use the projector 
near water or sources of heat.

■ Use the type of power source indicated on the projector. If you’re not sure of the power 
available, consult your dealer or power company.

■ Place the projector near a wall outlet where the plug can be easily unplugged.

■ Don’t insert the plug into an outlet with dust present, and insert the plug firmly into the 
outlet. Failure to do so could result in sparks or fire.

■ Don’t overload wall outlets, extension cords, or integral convenience receptacles. This can 
cause fire or electric shock.

■ Don’t block the slots and openings in the projector case. They provide ventilation and 
prevent the projector from overheating. Don’t operate the projector on a sofa, rug, or 
other soft surface, or in a closed-in cabinet unless proper ventilation is provided.

■ Never push objects through the cabinet slots or spill liquid into the projector.

■ Unplug the projector from the wall outlet and refer servicing to qualified service 
personnel under the following conditions: when the power cord or plug is damaged or 
frayed; if liquid has been spilled into the projector, or if it has been exposed to rain or 
water; if it doesn’t operate normally when you follow the operating instructions, or if it 
exhibits a distinct change in performance, indicating a need for service; if it has been 
dropped or the housing has been damaged.

■ Don’t place the projector where the cord can be walked on. This may result in fraying or 
damage to the plug.
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■ Unplug the projector from the wall outlet before cleaning. Use a damp cloth for cleaning. 
Do not use liquid or aerosol cleaners.

■ This product includes a lamp component that contains mercury. Please consult your state 
and local regulations regarding proper disposal or recycling, and do not place in the trash.

■ Unplug the projector during lightning storms or when not in use for extended periods.

■ Don’t place the projector or remote control on top of heat-producing equipment.

■ If you use the projector in a country other than where you purchased it, use the correct 
power cord for that country.

■ Don’t stand on the projector or place heavy objects on it.

■ Don’t use the projector outside of the required temperature range of 41 to 95 °F (5 to 
35 °C). Doing so may cause an unstable display and could lead to projector damage.

■ Don’t store the projector outside of the required temperature range of 14 to 140 °F 
(-10 to 60 °C) or in direct sunlight for long periods of time. Doing so may cause damage 
to the case.

Remote Control Information

You can operate the projector by remote control via a line-of-sight infrared (IR) receiver at the 
front and rear of the projector. The projector may not respond to remote control commands 
under the following conditions:

■ There is an object between the remote control and the IR receiver on the projector.

■ Ambient light is too bright.

■ Certain types of fluorescent lighting are used.

■ Other equipment that emits infrared energy, such as a radiant room heater, is in the 
room.

If you experience problems, try the following:

■ The remote control’s battery may be low on power; replace it.

■ Dim the ambient lighting and/or turn off any fluorescent lights.

■ Close any window coverings and/or move the projector out of direct sunlight.

■ Turn off other equipment that emits infrared energy.
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
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Presenting the EPSON PowerLite 
Home 10

The EPSON® PowerLite® Home 10 Theater Projector lets you enjoy high-quality projection 
in the relaxing environment of your own home. It offers these powerful features:

■ Adjustable color modes with built-in cinema filter for great viewing

■ 16:9 LCD panel for wide format projection

■ Five setup configurations, including front or rear projection and ceiling mounted 
installation

■ Short lens focus; you can project an 80-inch diagonal image with the projector just 
6.6 feet away

■ 700:1 contrast ratio

■ Extra parental control through the projector’s child lock option

■ Lock port for optional Kensington® MicroSaver® anti-theft device

■ Toll-free two-year priority technical support

Registration and Warranty

The EPSON PowerLite Home 10 projector comes with a basic two-year carry-in warranty. 
For details, see page 43.

In addition, for customers who register their projector, EPSON offers free Extra CareSM 
Home Service. In the unlikely event of an equipment failure, you won’t have to wait for your 
unit to be repaired. Instead, EPSON will ship you a replacement unit anywhere in the United 
States or Canada, usually via overnight delivery. See your Extra Care Home Service brochure 
for details.

To register, simply fill out the registration card that came with your projector and mail it to 
EPSON. Or you can register online at http://www.epson.com/webreg. Registering also lets 
you receive special updates on new accessories, products, and service.THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
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Projector Parts

Control panel

Infrared receiver

Ventilation slots

Lens cover

Focus lever

Zoom lever

Adjustable 
foot

Speaker

Remote control 
holder

S-video port Video port 
(composite video)

Input B (computer) Input A (component video)

AC power inlet

Infrared receiver

Audio ports Kensington 
security lock

Control port for 
service use only
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Projection Controls

Power button

Turns the projector on and off

Power light

Indicates operating 
status

Warning light

Alerts you to 
problems 

Keystone 

correction and 

volume 

buttons

Also used to 
navigate the 
projector’s menus

Menu button

Displays or hides 
projector’s menus

Source button

Switches the video input source

Esc button

Exits the current 
function or menu

Aspect button

Changes the 
picture’s aspect 
ratio 

Select button

Selects a menu item or 
advances to the next menu

Source buttons

Switch between equipment 
connected to the projector

Color Mode button

Selects the Color Mode

Power button

Turns the projector 
on and off

Memory button

Recalls settings made in 
the projector’s menus

Aspect button

Changes the picture’s 
aspect ratio

Arrow and Select buttons

Navigate menus and select 
menu items

Volume buttons

Adjust volume

A/V Mute button

Turns off audio and video

Still button

Freezes the picture and sound

ESC button

Exits the current function 
or menu

Auto button

Optimizes images 
from a computer

Menu button

Displays or hides projector’s 
menus
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Using This Manual

See the Quick Setup sheet to connect the projector to your video or computer equipment. 
This book contains all the information you need to use the projector, in addition to 
maintenance instructions, troubleshooting tips, important safety instructions, specifications, 
and warranty information.

Please follow these guidelines as you read through the manual:

Warnings:  Must be followed carefully to avoid bodily injury.

Cautions:  Must be observed to avoid damage to your equipment.

Notes:  Contain important information about your projector.

Tips:  Contain helpful projection tips.

Getting More Information

Need additional help? Take advantage of EPSON’s automated support services 24 hours a 
day at http://support.epson.com. Use this site to download FAQs or product information and 
e-mail your questions to EPSON support.

If you need more help, you can use the EPSON PrivateLine® Support service. Call 
(800) 637-7661 and enter the PIN on the PrivateLine support card that came with your 
projector. 
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Supported Devices

You can connect the projector to any of the following video sources: VCR, DVD player, 
DTV decoder, HDTV tuner, videodisc player, cable/satellite box, TV, video game console, 
audio/video receiver, camcorder, personal video recorder, digital camera, or laser disc player. 
You can also connect to a desktop or laptop PC or Apple® Macintosh® system.

The projector supports composite video, S-video, and component video, and it automatically 
senses the video format (HDTV, NTSC, PAL, or SECAM).

The Quick Setup sheet explains how to connect your projector to your other equipment. For 
cable requirements, see the next section.

Cable Requirements

The projector does not come with any cables. However, you may already have the ones you 
need, or you can purchase them from EPSON, as described in the next section.

■ To receive a composite video signal, you need an RCA video cable. (One is usually 
provided with your video equipment.)

■ To receive an S-video signal, you need an S-video cable. (One is usually provided with 
your video equipment.)

■ To receive a component video signal from a DVD player, HDTV tuner, or other video 
device, you need a component video cable.

■ To connect a computer to the projector, you need a VGA computer cable.

■ Some older PowerBooks® and Macintosh desktop models may need a Macintosh adapter 
set. (You can purchase this from EPSON; see the next section for details.) Older iMac® 
systems may need a special adapter to provide a VGA output port; see your computer 
dealer.
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Optional Accessories

EPSON provides the following optional accessories for the projector:

You can purchase many of these accessories from your dealer, by calling EPSON 
at (800) 873-7766, or by visiting the EPSON StoreSM at www.epsonstore.com 
(U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Product Part number

Replacement lamp V13H010L2H

Air filter replacement V13H134A04

Remote control V12H007T12

Customized carrying cases:
Samsonite® wheeled soft case
Samsonite soft shoulder bag

ELPKS35
ELPKS43

Ceiling mount
Suspension adapter
False ceiling plate

ELPMB42
ELPMBAPL
ELPMBFCP

Kensington® security lock ELPSL01

Projection screens:
50-inch portable screen 
60-inch portable pop-up screen
80-inch portable pop-up screen

ELPSC06
ELPSC07
ELPSC08

Macintosh adapter set (includes monitor adapter 
and desktop adapter)

ELPAP01

S-video cable ELPSV01
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Using the Projector

Follow the instructions in this section to choose a location for the projector, adjust the image 
and volume, turn off picture and sound, freeze the action, or use the projector menus.

Choosing a Location

The distance from the projector to the screen or wall determines the size of the picture. The 
picture will be larger when you place the projector further from the screen. See the Quick 
Setup sheet for details about the relationship between distance and picture size.

You can also choose from five different viewing setups. If you install the projector in a rear or 
overhead position, you’ll need to choose the correct Projection option (identified below) from 
the projector’s Setting menu. 

■ Table: For temporary front projection, place the projector on a 
low table in front of the screen. If possible, place the projector 
directly in front of the screen, facing the screen squarely. The 
base of the lens should be about level with the bottom of the 
screen.

■ Shelf: You can also place the projector on a high shelf behind 
you. Attach the three rubber feet that came with the projector 
to the top of the projector, then place the projector 
upside-down. After you turn on the projector, choose 
Front/Ceiling for the Projection option in the Setting menu.

■ Ceiling: You can purchase special equipment from EPSON to 
attach the projector to your ceiling (see page 12 for ordering 
information). If you choose this setup, professional installation 
is recommended. Choose Front/Ceiling for the Projection 
option.

Shelf

Table

Ceiling
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■ Rear: You can also set up your projector behind a 
translucent screen. Choose Rear for the Projection 
option.

■ Rear/Ceiling: Professional installation is 
recommended if you choose to attach the 
projector to the ceiling behind a translucent 
screen. (See page 12 for information about 
ordering ceiling mounting equipment.) Choose 
Rear/Ceiling for the Projection option.

Adjusting the Picture

Follow the steps on the Quick Setup sheet to connect the projector to your 
equipment and turn it on. Be sure to follow these guidelines when turning the 
projector on or off:

■ Turn your video equipment on or off before you turn your projector on or 
off. (If you’re attaching the projector to a computer, turn the projector on or 
off first.)

■ Press the P Power button on the remote control to turn the projector on 
or off.

■ Never unplug the projector when the P power light on the projector’s control 
panel is green or flashing orange.

Once you see your picture, you may need to make certain adjustments.

Note: If you don’t see a picture, you may need to change the image source. See 
page 33 for details.

1. To raise the picture, turn the projector’s front feet.

Rear

Rear/Ceiling
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2. Rotate the focus ring to sharpen the picture, or the zoom ring to reduce or 
enlarge it.

3. If your image looks like  or , press the  and  buttons on the projector’s 
control panel until the image is corrected.

4. To optimize color settings, press the Color Mode button on the remote control to 
choose from these four pre-set color modes:

■ Dynamic
For projecting in bright rooms; images will have greater color intensity.

■ Living Room
For projecting in rooms with a lot of ambient light; images retain natural color.

■ Theatre
For projecting movies or images with dark scenes.

■ Theatre Black
For projecting images in a dark room; lamp brightness decreases and image contrast 
increases.

5. To change the picture’s aspect ratio (ratio between length and height), press the Aspect 
button on the projector or remote control. Choose from these settings:

■ Normal
Maintains the aspect ratio of the projected image on a 16:9 (wide-screen format) 
screen; when you project 4:3 images, black bands appear on the sides.

■ Squeeze
Best for projecting wide-screen format (16:9) images; when images output in 4:3 
format are projected, they are elongated horizontally.

■ Zoom
Crops images output in 4:3 format at the top and bottom and then projects them in 
16:9 format.

Focus lever

Zoom lever
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Adjusting the Volume

Use the control panel to adjust the volume of the projector’s audio system or speakers 
connected directly to the projector’s Audio ports:

■ Press the  button to decrease the volume.

■ Press the  button to increase the volume.

Turning Off the Picture and Sound

You can use the A/V Mute button on the remote control to darken your screen and turn off 
the sound. This is useful if you pause the video.

■ To turn off the picture and sound, press the A/V Mute button. The screen goes dark.

■ To turn the picture and sound back on, press the A/V Mute button again.

Use your video device’s controls to pause the video. If you don’t pause it, it continues to play 
even though you don’t see or hear it. When you press the A/V Mute button again, playback 
won’t resume where you stopped it.

Freezing the Action

To freeze the action temporarily on the screen, press the Still button on the remote control. 
This freezes any moving images until you press the Still button again.

Like the A/V Mute feature, the video and audio input continue while the moving images are 
paused, so when you press the Still button again, playback doesn’t resume exactly where you 
stopped it.
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Using the Projector’s Menu System

You can use the projector’s on-screen menus to fine-tune the image quality, check lamp usage, 
and customize projector features:

■ The Image menu controls the look and quality of the picture. It offers several ways to 
adjust the color and improve the sharpness and clarity of the picture.

■ The Setting menu lets you set the child lock or sleep mode, adjust the position and size 
of the picture, select front or rear projection, and customize other projector features.

■ The Info menu provides information about lamp status and video or computer settings.

■ The Reset menu lets you reset the lamp timer and the projector’s memory, or return all 
the menu settings to their factory defaults.

You can use the buttons on the projector or remote control to display the menus and change 
settings. Follow the steps in the next section.

Changing Menu Settings

1. Press the Menu button on the projector or remote control. You see one of the following 
screens (the screen you see depends on the equipment you’ve connected):

The four menus are shown on the left, and the options available to the highlighted menu 
are shown on the right. 

Note: If nothing is connected to the projector, some options may not be available.

2. Press the up or down arrow button on the remote control or the  or  button on the 
projector to move to the menu you want. When your menu is highlighted, press the 
Select button. You see the options for the selected menu on the right. The highlight 
moves to the first option in the list.
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3. Press the up or down arrow button on the remote control or the  or  button on the 
projector to move through the list of options. When the option you want to change is 
highlighted, press the Select button.

You may see a list of settings, a submenu providing additional options, or a line menu or 
slider bar similar to the one below:

4. If you see a list of settings, use the arrow buttons on the remote control or the  or  
button on the projector to move to the setting you want, then press the Select button. 
Enabled settings are indicated by a green light, while disabled ones are gray.

If an option has a submenu, press the Select button to display it, then select the setting 
you want.

If you see a line menu or slider bar, press the left or right arrow button on the remote 
control or the  or  button on the projector to change the setting.

5. Press the Esc button to return to the previous menu.

6. Press the Menu button to exit the menu system.

Adjusting the Appearance of the Picture

The Image menu lets you make a variety of adjustments to the projected image to get the best 
color and quality.

The options available depend on which type of equipment is connected to the projector:

Image menu for component video, 
composite video, or S-video

Image menu for computer 
or RGB video
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1. Press the Menu button. You see the menu screen.

2. Press the Select button to select the Image menu. Then press the Select button again to 
select Picture Quality.

3. Use the arrow buttons on the remote control or the , ,  or  buttons on the 
projector to set the following options:

■ Brightness
Adjusts the brightness of the picture. Increase (+) the setting to make the picture 
brighter, or decrease (-) the setting to reduce brightness.

■ Contrast
Adjusts the contrast between colors or shades in the picture. 

■ Sharpness
Adjusts the sharpness of the picture.

■ Saturation (video only)
Adjusts the color depth of the picture.

■ Tint (component or NTSC video only)
Adjusts the tint or hue of colors in the picture.

■ Color Temperature
Adjusts red or blue tones. A lower color temperature produces a picture with more 
red, while a higher color temperature produces more blue and sharper color tones.

■ Flesh Tone
Adjusts the balance of green to magenta in the image.

■ Tracking (computer images only)
Removes unwanted vertical lines from a computer image by matching the projector’s 
internal clock to the computer display signal.

■ Sync (computer images only)
Corrects fuzziness by synchronizing the projector with the tracking signal sent from 
the computer.

4. Select the Color Mode option and choose from these settings:

■ Dynamic
For projecting in bright rooms; images will have greater color intensity.

■ Living Room
For projecting in rooms with a lot of ambient light; images retain their natural color.THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
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■ Theatre
For projecting movies or images with dark scenes.

■ Theatre Black
For projecting in a dark room; lamp brightness decreases and image contrast 
increases.

5. To save the adjustments you made in the Image menu, select the Memory option. Select 
Memory 1 to save your first set of adjustments. Later you can recall these settings by 
pressing the Memory button on the remote control. 

Note: You can save a second set of adjustments by selecting Memory 2. Press the Memory 
button on the remote control twice to select this second set.

6. Press Esc or Menu to exit the menu system.

Customizing Projector Operation

You can use the Setting menu to set the child lock or sleep mode, adjust the position or size of 
the picture, select front or rear projection, and customize other projector features.

1. Press the Menu button to display the menu screen.

2. Press the down arrow button on the remote control or the  button on the projector to 
highlight the Setting menu, and then press the Select button. You see these settings:

3. Press the Select button again to select the Screen option.
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4. Use the arrow buttons on the remote control or the , ,  or  buttons on the 
projector to set these options:

■ Position
See “Repositioning the Picture” on page 22.

■ Zoom Caption
Adjusts both the length of the picture and its vertical position on the screen. You can 
adjust this function only when you’ve selected the Zoom aspect ratio.

■ Keystone
Corrects vertical keystone distortion of the image (when your image looks like  or 

). This procedure makes the image smaller. 

■ Projection
Selects the projection method, as follows: 

■ Setup Level (for component video, S-video, and NTSC video only)
If you are using the projector with non-standard video equipment that has different 
black level settings, use this setting to adjust the level of black in the image. See the 
documentation that came with your video equipment for more information.

5. Select the Operation option to make changes to these settings:

■ Sleep Mode
When sleep mode is on, the projector turns off the lamp if it has not received any 
input signals for the specified amount of time (5, 10, or 30 minutes). You can also 
turn sleep mode off.

■ Child Lock
When this feature is on, the projector will not come on unless you press and hold the 
P Power button on the control panel for three seconds. (The remote control 
operates normally.)

Setting Projector position

Front Projector is in front of the screen

Front/Ceiling Projector is in front of the screen, 
positioned upside-down on a shelf or 
mounted upside-down on the ceiling

Rear Projector is behind the screen

Rear/Ceiling Projector is behind the screen, mounted 
upside-down from the ceiling
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6. Select the On Screen Display option to make changes to these settings:

■ Message
Turn this option off if you don’t want to display the No Signal message or the name 
of the input source or color mode. Warning messages are still displayed.

■ Background Color
Selects the screen color to display (blue or black) when you press the 
A/V Mute button on the remote control.

■ Startup Screen
Turn on this option to display the EPSON logo whenever the projector starts.

7. Select the Input Signal option to configure the input signal from your video equipment:

■ Video Signal (composite or S-video signals only)
Leave this set at Auto unless your input source is N-PAL format or the 
documentation for your video equipment specifies a setting.

■ Input A (component and RGB video signals only)
Specifies the format for the video source connected to the Input A ports. Select either 
Component or RGB Video.

8. Select the Volume option to adjust the volume of the projector’s audio system or 
speakers connected to the projector’s Audio ports.

9. Select the Language option to choose the language you want to use for the projector 
menus.

Repositioning the Picture

Follow these steps to move the picture to a different position on the screen:

1. Press the Menu button to display the menu screen.

2. Press the down arrow button on the remote control or the  button on the projector to 
highlight the Setting menu. Then press Select.

3. Select the Screen option, then select the Position option. You see a positioning screen.

4. Use the arrow buttons on the remote control or the , ,  or  buttons on the 
projector to move the image left, right, up, or down.

5. When the image is positioned the way you want it, press the Menu button to exit.
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Viewing Lamp Usage and Other Information

Use the Info menu to view information about the display settings of your input source and 
the number of hours the lamp has been used.

1. Press the Menu button to display the menu screen.

2. Press the down arrow button on the remote control or the  button on the projector to 
highlight the Info menu. Then press Select. If the projector is connected to video 
equipment, you see these settings:

If the projector is connected to a computer, you see these settings:

The life span of the lamp is about 3000 hours if the color mode is consistently set to Theatre 
Black, and 2000 hours if any other color mode is used. If the number shown is close to the 
limit, make sure you have a spare lamp handy.

After you change the lamp, you need to reset the lamp timer. See “Replacing the Lamp” on 
page 28 and “Resetting the Lamp Timer” on page 30.
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Restoring the Default Settings

The Reset menu lets you reset the lamp timer and the projector’s memory, or return all the 
projector settings to their factory default values.

1. Press the Menu button to display the menu screen.

2. Press the down arrow button on the remote control or the  button on the projector to 
highlight the Reset menu. Then press Select. You see this menu:

3. Change any of the following settings:

■ Lamp-Hours Reset
See page 30 for detailed information.

■ Memory Reset
Resets all settings stored in the projector’s memory.

■ All Reset
Resets all settings to their factory default values. The only settings not affected by this 
option are input signal, language, lamp hours, and memory.
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Caring for the Projector

Your projector needs little maintenance. All you need to do on a regular basis is keep the lens 
clean. You also need to clean the air filter periodically to prevent overheating.

Warning: Before you clean any part of the projector, turn it off and unplug the power cord. 
Never open any cover on the projector, except the lamp and filter covers. Dangerous 
electrical voltages in the projector can injure you severely. Do not try to service this 
product yourself, except as specifically explained in this User’s Guide. 

The only parts you should replace are the lamp and air filter. If another part needs replacing, 
contact your dealer or a qualified servicer.

Follow the instructions in this section to clean the lens and projector case, change the remote 
control’s battery, clean and replace the air filter, replace the lamp, and store or transport the 
projector.

Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface.

■ Use a canister of compressed air to remove dust.

■ To remove dirt or smears, use lens-cleaning paper. If necessary, moisten a soft cloth with 
lens cleaner and gently wipe the lens surface.

Caution: Never rub the lens with abrasive materials.
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Cleaning the Projector Case

Before you clean the case, turn off the projector and unplug the power cord.

■ To remove dirt or dust, wipe the case with a soft, dry, lint-free cloth.

■ To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral 
detergent. Then wipe the case.

Caution: Never use wax, alcohol, benzene, thinner, or other chemical detergents. These 
can damage the case.

Changing the Remote Control’s Battery

You can obtain a replacement CR2025 lithium battery commercially. 

Warning: Keep batteries away from children. If a child swallows the battery, contact your 
doctor immediately.

1. Press the catch in as you pull the battery holder out.

2. Remove the old battery and insert the new one. The plus mark (+) on the battery should 
be face up.

3. Reinsert the battery holder in the remote control. Press in until it clicks into place.

Catch
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Cleaning and Replacing the Air Filter

Clean the air filter on the bottom of the projector after every 100 hours of use. If it’s not 
cleaned periodically, it can become clogged with dust, preventing proper ventilation. This can 
cause overheating and damage the projector.

1. Turn off the projector and wait for the P power light to stop flashing.

2. Unplug the power cord and disconnect any cables.

3. Turn the projector over. Then use a small vacuum 
cleaner designed for computers and other office 
equipment to clean the filter, as shown. If you don’t have 
one, gently clean the filter using a very soft brush (such 
as an artist’s camel-hair brush).

If the dirt is difficult to remove or the filter is broken, 
replace it. Contact your dealer or call EPSON at (800) 
873-7766 and ask for part number V13H134A04. In 
Canada, call (800) 463-7766 for dealer referral.

4. If you need to replace the filter, press the tab in and lift the 
cover up.

5. Remove the old filter and replace it with a new one.

6. To replace the cover, insert the tabs and press down until the 
cover clicks into place.
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Replacing the Lamp

It’s time to replace the lamp when:

■ The projection image gets darker or starts to deteriorate.

■ The projector’s warning light flashes red at half second 
intervals.

■ The message Replace the lamp appears on the screen 
when you start projecting.

Contact your dealer or call EPSON at (800) 873-7766 in the United States for a replacement 
lamp. Request part number V13H010L2H. In Canada, call (800) 463-7766 for dealer referral.

Be sure to read the “Important Safety Information” on page 5 before replacing the lamp. 

Warning: Let the lamp cool before replacing it. If the lamp breaks, handle the shards 
carefully to avoid injury. If your projector is mounted on the ceiling, take it down before 
beginning this procedure. 

The lamp component contains mercury. Please consult your state and local regulations 
regarding proper disposal or recycling, and do not place in the trash.

Caution: Never touch the lamp with your bare hands; the invisible residue left by the oil on 
your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Follow these steps to replace the lamp:

1. Turn off the projector and wait for the P power light to stop flashing.

2. Unplug the power cord and any cables.

3. If the projector has been on, let it cool for at least an hour.

4. Press in on the two tabs and lift the lamp cover up and off.
.
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5. Use a small screwdriver to loosen the two silver screws holding the lamp in place. (You 
can’t remove these screws.)

6. Grasp the lamp as shown and pull it straight out.

7. Gently insert the new lamp and tighten its screws.

Caution: Don’t touch the glass portion of the lamp assembly. Touching the glass could 
result in premature lamp failure.

8. To replace the lamp cover, insert the tabs and then snap the cover into place. (The 
projector won’t work if the lamp cover is loose.)

After replacing the lamp, you need to reset the lamp timer, as described in the next section.

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



30

Resetting the Lamp Timer

1. Press the Menu button on the projector or remote control.

2. Highlight the Reset menu and press the Select button.

3. Select Lamp Hours Reset. 

4. When you see a prompt asking whether you want to execute the command, highlight Yes 
and press the Select button.

5. When you’re finished, press Esc or Menu.

The lamp usage timer doesn’t register until you’ve used the lamp for at least 10 hours.

Storing the Projector

If you need to store the projector for awhile, do the following:

■ Make sure the temperature and humidity of the storage area are within the recommended 
range for the projector (14 to 140 °F [-10 to 60 °C] and 10 to 90% relative humidity).

■ Attach the lens cover and retract the feet.

■ Remove the battery from the remote control.

■ Package the projector in its original packaging or equivalent (as described in the following 
section).

Transporting the Projector

Note: EPSON shall not be liable for any damages incurred during transportation.

The projector contains many glass and precision parts. If you need to transport it, follow these 
guidelines to prevent damage:

■ When shipping the projector for repairs, use the original packaging material if possible. If 
you do not have the original packaging, use equivalent materials, placing plenty of 
cushioning around the projector. Be sure the carrier is capable of transporting fragile 
equipment and is aware that the projector is fragile.

■ When you are hand-carrying the projector, grip the recessed handles on the sides.
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Problem Solving

This section explains how to interpret the projector’s status lights, solve problems with the 
picture and remote control, and contact technical support.

What To Do When the Lights Flash

The lights on top of the projector indicate the 
projector’s status and let you know when a 
problem occurs.

If the projector isn’t working correctly, first turn 
it off, let it cool, and unplug it. Then plug the 
power cord back in and turn on the projector. If 
this doesn’t solve the problem, check the status 
lights on top of the projector.

The P power light is orange.

The projector is in standby mode. Unplug it or press the P Power button to turn it on.

The P power light is flashing green.

The projector is warming up. Wait for the picture to appear.

The P power light is flashing orange and you can’t turn on the projector.

The lamp is cooling down. Wait until the light stops flashing, then press the P Power 
button.

The P power light does not come on.

Make sure the power cord is connected securely both at the power outlet and the projector. If 
you’ve just replaced the lamp, make sure the cover is securely fastened.

Power light

Warning light

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



32

The warning light is flashing orange.

High-speed cooling is in process. If the projector gets too hot again, projection stops 
automatically. Make sure there is plenty of space around and under the projector for 
ventilation. Clean or replace the air filter if necessary. See page 27 for details.

The warning light is red.

The projector is too hot, which turns off the lamp automatically. Let it cool for five minutes, 
then turn it back on. Make sure there is plenty of space around and under the projector for 
ventilation. Also, clean or replace the filter if necessary. See page 27.

The warning light is flashing red at half second intervals.

There’s a problem with the lamp. First check the Info menu to see if you need to replace the 
lamp (see page 23). If that’s not the problem, turn off the projector. When the P power light 
stops flashing, unplug the projector. Then take the lamp out to make sure it’s not broken. 

Warning: Let the lamp cool before taking it out. If the lamp is broken, handle the shards 
carefully to avoid injury. If your projector is mounted on the ceiling, take it down before 
attempting to remove the lamp.

The warning light is flashing red at one second intervals.

■ The lamp cover may be loose or off. Make sure it’s securely fastened. See page 29.

■ There is an internal problem. Turn off the projector and, when the P power light stops 
flashing, unplug it. Contact your dealer.

Solving Picture Problems

No picture appears on the screen.

■ Check that the P power light is green, not flashing, and the lens cover is off. If you’ve just 
turned the projector off, let it cool down for a couple of minutes.

■ The projector may be in standby (or sleep) mode. If the P power light is orange, press the 
P Power button to turn the projector on. 

■ Press the A/V Mute button on the remote control to make sure the picture hasn’t been 
turned off temporarily.THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



33

■ Check your cable connection.

■ Make sure your video equipment is on. If it isn’t, turn the projector off, then turn it on 
again after you’ve turned on your video equipment.

You see a screen with the message No Signal displayed.

■ Make sure your video equipment is turned on.

■ Make sure your cable(s) are connected correctly, as described in the Quick Setup sheet.

■ Press the Source button on the projector or the Input A/B or S-Video/Video buttons on 
the remote control to select the correct input source. Allow a few seconds for the 
projector to sync up.

■ Check the settings in the Video Signal and Input A options in the Setting menu to 
make sure they’re correct for your video equipment. See page 22 for details.

If you’re using a PC laptop:

■ Press the function key that lets you display on an external monitor. It’s often labeled with 
an icon such as , but it may also be labeled CRT/LCD. You may have to hold down 
the Fn key while pressing it. Check your laptop’s manual or online help.

On most systems, the  key lets you toggle between the LCD screen and the 
projector, or display on both at the same time. Allow a few seconds for the projector to 
sync up after pressing it.

■ Depending on your computer’s video card, you might need to use the Display utility in 
the Control Panel to make sure that both the LCD screen and external monitor port are 
enabled. See your computer’s documentation for details.

If you’re using a Macintosh laptop with OS X:

1. Select System Preferences from the Apple menu and click Displays.

2. Click Detect Displays.

3. To display the entire desktop on both your projector screen and LCD screen, click 
the Arrange tab. (If you don’t see this tab, make sure it isn’t hidden by another 
window.)
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4. Click Mirror Displays in the lower corner of the screen. One of the monitor icons 
automatically moves on top of the other.

If you’re using a Macintosh laptop with OS 9.x or earlier:

1. From the Apple menu, select Control Panels, then click Monitors and Sound.

2. Click the Arrange icon, and then drag one monitor icon on top of the other.

If the Arrange option isn’t available, you may need to select one of the Simulscan 
resolutions. Click the Monitor icon and then select a Simulscan resolution from the 
Resolution box. (Allow a few seconds for the projector to sync up.)

The picture is upside-down or reversed.

Change the setting for the Projection option in the Setting menu. See page 21.

Click here

Click here

Drag one 
monitor icon on 
top of the other
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Only part of the picture is displayed, or the picture is distorted.

■ Press the Aspect button to select a different aspect ratio.

■ Use the Position setting in the Setting menu to reposition the image on the screen. See 
page 22 for details.

The picture is trapezoid-shaped.

Press the  and  buttons on the projector to correct the problem.

The picture contains static or noise.

■ Make sure your cable is securely connected at both ends.

■ Don’t use an extension cable or a cable longer than 6 feet. 

■ If you’re displaying the same image on your computer and projector screen, try turning 
off your laptop’s LCD display.

The picture is blurry.

■ There may be dirt on the lens. Clean the lens as described on page 25.

■ Adjust the focus using the focus ring.

■ Make sure the lens is not fogged by condensation. If you’ve just moved the projector from 
a cold environment, wait a couple of minutes before using it.

■ Adjust the Sharpness setting on the Image menu (see page 19). If you’re projecting 
from a computer, you may also need to adjust the Tracking and Sync settings.

You see vertical stripes, or the picture still looks blurry after trying the solutions in the 
previous section.

If you’re projecting from a computer, press the Auto button on the remote control. This 
optimizes the projector’s tracking and sync settings. If this doesn’t work, change the Tracking 
and Sync settings in the projector’s Image menu.

The colors on the screen don’t look right.

■ Press the Color Mode button on the remote control to move through the different color 
mode settings.

■ Adjust the following settings in the Image menu: Brightness, Contrast, Saturation 
(video only), Tint (video only), Color Temperature, and Flesh Tone. See page 19.

■ If the picture looks darker, you may need to replace the lamp.
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Solving Remote Control Problems

The projector doesn’t respond to remote control commands.

■ Make sure you’re within 20 feet of the projector, and within range of the projector’s front 
or back sensor (approximately 30° left or right, and 15° above or below).

■ You may need to replace the remote control’s battery. See page 26 for details.

■ Dim the room lights and turn off any fluorescent lights. Make sure the projector is not in 
direct sunlight.

■ Turn off nearby equipment that emits infrared energy, such as a radiant room heater.

Where To Get Help

EPSON provides technical assistance 24 hours a day at http://support.epson.com. Here 
you can access troubleshooting information, download product documentation, and receive 
technical advice through e-mail.

To use the EPSON PrivateLine Support service, call (800) 637-7661 and enter the PIN on 
the EPSON PrivateLine Support card that came with your projector. This is the fastest way of 
speaking to a live representative, and it’s free. This service is available 6 AM to 6 PM, Pacific 
Time, Monday through Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one of these numbers:

■ U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday through Friday

■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday

Toll or long distance charges may apply.

Before you call, please have the following information ready:

■ Product name (EPSON PowerLite Home 10)

■ Product serial number (located on the bottom of the projector)

■ Computer configuration, if you’re connecting to a computer

■ Description of the problem

You can purchase screens, carrying cases, or other accessories from EPSON at 
(800) 873-7766 or by visiting the EPSON Store at www.epsonstore.com (U.S. sales only). In 
Canada, please call (800) 463-7766 for dealer referral.
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Specifications and Notices

General

Type of display Poly-silicon TFT active matrix

Size of LCD panels 0.55 inch (14 mm) wide

Lens F=1.7 to 2.1, f=13.9 to 21.4 mm

Resolution 
(native format) 854 × 480 pixels, 480p

Brightness 1000 lumens (ANSI)

Color reproduction 24 bit, 16.8 million colors

Contrast ratio 700:1

Image size 30 to 300 inches (0.76 to 7.6 m)

Projection distance 3.7 to 38 feet (1 to 11.6 m)

Internal sound system 1 W monaural

Zoom ratio 1:1.54

Optical aspect ratio 16.9

Noise level 35 dB (all color modes except Theatre Black)
29 dB (Theatre Black color mode)

Keystone correction Vertical: -15 to +15°

Projection Lamp 

Type UHE (Ultra High Efficiency)

Power consumption 132 W

Lamp life Approx. 2000 hours (all color modes except Theatre Black)
Approx. 3000 hours (Theatre Black mode)

Part number V13H010L2H

Remote Control

Range Approx. 20 feet (6 m)

Battery Lithium CR2025
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Dimensions

Height 4.5 inches (114 mm)

Width 15.8 inches (402 mm)

Depth 11.6 inches (294 mm)

Weight 7.9 lb. (3.6 kg)

Electrical

Rated frequency 50/60 Hz AC

Power supply 100 to 120 VAC, 2.3 A
200 to 240 VAC, 1.0 A

Power consumption Operating: 200 W at 100 VAC
Standby: 5 W at 100 VAC

Environmental

Temperature Operating: 41 to 95 °F (5 to 35 °C)
Storage: 14 to 140 °F (-10 to 60 °C)

Humidity Operating: 20 to 80% RH, non-condensing
Storage: 10 to 90% RH, non-condensing

Safety

United States FCC 47CFR Part 15B Class B (DoC)
UL1950 Rev. 3

Canada ICES-003 Class B
CSA C22.2 No. 950-95 (cUL)

CE Marking Directive 89/336/EEC
EN 55022, EN 55024

PixelworksTM DNXTM ICs are used in this projector.
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Compatible Video Formats

The projector supports HDTV, NTSC, PAL, and SECAM international video standards, as well as the 
monitor display formats listed below. To project images from a computer, set the computer’s video 
card at a refresh rate (vertical frequency) compatible with the projector; see the table below for 
compatible formats. Some images are automatically resized to display in the projector’s native 
resolution (480p). Also, the frequencies of some computers may not allow images to display correctly; 
see your computer’s documentation.

* Resized to native resolution

Mode Refresh Rate (Hz) Resolution

HDTV (750p)
HDTV (1125i)
HDTV (1125i)
SDTV (525i)
SDTV (525p)
SDTV (625p)
SDTV (625i)

60
60
50
60
60
50
50

1280 × 720*

1920 × 1080*

1920 × 1080*

640 × 480
640 × 480
768 × 576
768 × 576

VGAEGA 70 640 × 350*

VGA—60
VESA—72
VESA—75
VESA—85

60
72
75
85

640 × 480*

640 × 480*

640 × 480*

640 × 480*

SVGA—56
SVGA—60
SVGA—72
SVGA—75
SVGA—85

56
60
72
75
85

800 × 600*

800 × 600*

800 × 600*

800 × 600*

800 × 600*

XGA—43i
XGA—60
XGA—70
XGA—75
XGA—85

43
60
70
75
85

1024 × 768*

1024 × 768*

1024 × 768*

1024 × 768*

1024 × 768*

MAC13
MAC16
MAC19
MAC19—60
MAC21

67
75
75
59
75

640 × 480*

832 × 624*

1024 × 768*

1024 × 768*

1152 × 870*

NTSC 
NTSC 4:43
PAL
N-PAL
M-PAL
PAL—60
SECAM

60
60
50
50
60
60
50

—
—
—
—
—
—
—
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FCC Compliance Statement

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the 
FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment 
interface cable with this device. If this equipment has more than one interface connector, do not leave 
cables connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU 
Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 
Located at: 3840 Kilroy Airport Way

MS 3-13
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Projector
Model: EMP-TW10
Marketing Name: PowerLite Home 10

EPSON AMERICA, INC. LIMITED WARRANTY

What Is Covered: Epson America, Inc. (“EPSON”) warrants to the original end user customer that the 
EPSON product enclosed with this limited warranty statement, if purchased and used in the United 
States or Canada, conforms to the manufacturer’s specifications and will be free from defects in 
workmanship and materials for a period of two (2) years from the date of original purchase (except that 
the warranty period is 90 days for projector lamps). For warranty service, you must provide proof of the 
date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON projector require service during the 
warranty period, EPSON will, at its option, exchange or repair the projector without charge for parts 
or labor. If EPSON authorizes an exchange for the defective unit, EPSON will ship a replacement 
projector to you, freight prepaid, to an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to EPSON within five (5) working days of receipt of the 
replacement. EPSON requires a debit or credit card number to secure the cost of the replacement 
projector in the event that you fail to return the defective one. If your projector is being repaired by 
carry-in warranty service, please bring the product securely packaged in its original container or an 
equivalent to your EPSON Dealer or EPSON Customer Care Center. EPSON will, at its option, 
repair or replace on an exchange basis the defective unit, without charge for parts or labor. When 
warranty service involves the exchange of the product or of a part, the item replaced becomes EPSON 
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property. The exchanged product or part may be new or previously repaired to the EPSON standard of 
quality, or, at EPSON’s option, may be another model of like kind and quality. Exchange or 
replacement products assume the remaining warranty period of the product covered by this limited 
warranty, except that each replacement lamp carries the limited 90-day warranty stated above.

What This Warranty Does Not Cover: This warranty covers only normal use of the product in the 
United States and Canada. 24-hour-per-day use of this product causes unusual strain and is not 
considered normal use. This warranty does not cover consumables (e.g., fuses), other than lamps. This 
warranty does not apply to refurbished or reconditioned products, and this warranty is not transferable. 
EPSON is not responsible for warranty service should the EPSON label or logo or the rating label or 
serial number be removed or should the product fail to be properly maintained or fail to function 
properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused 
by disasters such as fire, flood, and lightning, improper electrical current, software problems, 
interaction with non-EPSON products, or service other than by an EPSON Authorized Servicer. 
Postage, insurance, or shipping costs incurred in presenting your EPSON product for carry-in warranty 
service are your responsibility. If a claimed defect cannot be identified or reproduced in service, you 
will be held responsible for costs incurred. 

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. 
IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED 
TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY 
STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE 
VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON 
AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, 
INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE 
EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY 
OTHER LEGAL THEORY. IF THE REMEDY ABOVE FAILS, EPSON’S ENTIRE LIABILITY 
SHALL BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE EPSON PRODUCT 
COVERED BY THIS LIMITED WARRANTY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you.This warranty gives you specific legal rights, and 
you may also have other rights, which vary from jurisdiction to jurisdiction.

To locate the Authorized EPSON Servicer nearest you, call the EPSON ConnectionSM at 
(800) 637-7661 + PIN or (562) 276-4394 in the U.S. and (905) 709-3839 in Canada, or write to: 
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
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Index

A

A/V Mute button, 9
Accessories, 12, 36
Air filter

cleaning and replacing, 27
ordering, 12

Anti-theft device, 12
Aspect button, 9, 15, 35
Auto button, 9, 35

B

Battery, changing, 26
Blurry picture, 35
Brightness, 37

C

Cables, 11 to 12
Ceiling projection, 13 to 14, 21
Child Lock, 21
Cleaning

air filter, 27
lens and projector case, 25, 26

Color Mode, 9, 15, 19, 35
Color problems, 35
Contrast ratio, 7, 37
Control panel, projector, 9

D

Default settings, resetting, 24
Desktop adapter, Macintosh, 12
Documentation, 10

E

Electrical requirements, 38
EPSON

accessories, 12, 36
Home Service, 7
PrivateLine Support, 36
technical support, 10, 36

F

Filter, see Air filter
Focus lever, 8, 15
Freeze image, 16

H

HDTV images, video formats, 39
Help, 36
Home Service, 7

K

Kensington anti-theft device, 12
Keystone correction, 15, 21, 34

L

Lamp
ordering, 12, 28
replacing, 28 to 29
safety instructions, 5 to 6
specifications, 37
viewing usage, 23

Lamp timer, resetting, 30
Lens, cleaning, 25
Lights, projector, 31 to 32
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M

Macintosh desktop adapter, 12
Memory button, 9, 20
Menu button, 9
Menus

adjusting picture quality, 18 to 20
using, 17 to 18

Moving projector, 30

P

Picture problems, 32 to 35
Picture, repositioning, 22
Problems

picture, 32 to 35
remote control, 6, 36

Projection option, 21
Projector

choosing location, 13 to 14
cleaning, 26
control panel, 9
dimensions, 38
lights, 31 to 32
parts, 8
resetting default values, 24
storing, 30
transporting, 30

R

Rear projection, 13 to 14, 21
Registration, 7
Remote control

buttons, 9
changing battery, 26
problems, 6, 36

Replacing lamp, 28 to 29
Resetting lamp timer, 30
Resolution, 37

S

Safety approvals, 38
Safety instructions, 5 to 6
Sleep Mode, 21
Sources, switching, 9, 33
Specifications

compatible video formats, 39
electrical, 38
environmental, 38
general, 37
lamp, 37
remote control, 37

Storing projector, 30
Support, see Technical support
Sync, 19, 35

T

Technical support, 10, 36
Tracking, 19, 35
Transporting projector, 30

V

Video cables, 11 to 12
Video, compatible formats, 39
Volume, adjusting, 9, 16, 22

W

Warranty, 7, 41 to 42

Z

Zoom lever, 8, 15
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Sponsored by DDMM

This user manual is provided as a free service by FixYourDLP.com.  FixYourDLP is in no way responsible
for the content of this manual, nor do we guarantee its accuracy.  FixYourDLP does not make any claim
of copyright and all copyrights remain the property of their respective owners.

About FixYourDLP.com
FixYourDLP.com (http://www.�xyourdlp.com) is the World’s #1 resource for media product news, 
reviews, do-it-yourself guides, and manuals.

Informational Blog:  http://www.�xyourdlp.com
Video Guides: http://www.�xyourdlp.com/guides
User Forums: http://www.�xyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.�xyourdlp.com/counterfeits

RecycleYourLamp.org – Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research  - The trusted 3rd party lamp research company: 
http://www.lampresearch.com

Discount-Merchant.com – The worlds largest lamp distributor:
http://www.discount-merchant.com
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